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Preface 

Data Analytics (315326) laboratory manual is meticulously crafted to equip fifth semester 

diploma engineering students with valuable practical learning experiences aligned with MSBTE 

'K' Scheme Curriculum. 

The primary objective of this manual is to create a product that is both aesthetically 

appealing and easy to interact. To achieve this, each practical is mapped with prescribed theory 

learning outcomes (TLOs), lab learning outcomes (LLOs) and course outcomes (COs). Course 

facilitators can adopt suitable pedagogical methods to impart the course with an aim to achieve 

the prescribed course outcomes effectively. 

This laboratory manual is designed to help all stakeholders, especially the students, teachers 

and instructors to develop in the student the pre-determined outcomes. It is expected from each 

student that at least a day in advance, they have to thoroughly read the concerned practical 

procedure that they will do the next day and understand minimum theoretical background 

associated with the practical. Every practical in this manual begins by identifying the 

competency, industry relevant skills, course outcomes and practical outcomes which serve as a 

key focal point for doing the practical. Students will then become aware about the skills they will 

achieve through procedure how there and necessary precautions to be taken, which will help 

them to apply in solving real-world problems in their professional life. 

 

This manual also provides guidelines to teachers and instructors to effectively facilitate 

student-centered lab activities through each practical exercise by arranging and managing 

necessary resources in order that the students follow the procedures and precautions 

systematically ensuring the achievement of outcomes in the students. 

 

Data Analytics is used to extract meaningful insights from raw data using various tools, 

techniques, and statistical methods. This course is designed to equip students with foundational 

principles and practical skills essential for analyzing and interpreting data effectively. By 

leveraging tools such as Excel and Python, students will learn how to collect, clean, visualize, 

and draw conclusions from data. The course will help students apply analytical thinking to real-

world scenarios and make data-driven decisions. 
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Program Outcomes (POs) to be achieved through Practical: 

PO1 

Basic and Discipline specific knowledge: Apply knowledge of basic mathematics, 

science and engineering fundamentals and engineering specialization to solve the 

engineering problems. 

PO2 
Problem analysis: Identify and analyses well-defined engineering problems using 

codified standard methods. 

PO3 
Design/ development of solutions: Design solutions for well-defined technical problems 

and assist with the design of systems components or processes to meet specified needs.  

PO4 
Engineering Tools, Experimentation and Testing: Apply modern engineering tools and 

appropriate technique to conduct standard tests and measurements. 

PO5 
Engineering practices for society, sustainability and environment: Apply appropriate 

technology in context of society, sustainability, environment and ethical practices. 

PO6 

Project Management: Use engineering management principles individually, as a team 

member or a leader to manage projects and effectively communicate about well-defined 

engineering activities.  

PO7 
Life-long learning: Ability to analyses individual needs and engage in updating in the 

context of technological changes. 
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Practical Course Outcome Matrix 

Course Outcomes (COs) 

CO1 Elaborate the fundamental concepts of Data Analytics. 

CO2 Apply appropriate statistical techniques to analyze and interpret complex Datasets. 

CO3 Analyze numerical data by creating pivot table. 

CO4 Represent data in terms of various types of charts. 

CO5 Visualize the data using a Python library. 

 

Sr. 

No. 
Title of the Experiment CO1 CO2 CO3 CO4 CO5 

1 

 *a. Calculate mean, median, and mode for a 

given dataset using Excel functions(AVERAGE, 

MEDIAN, MODE). 

*b. Calculate range, interquartile range 

(IQR),variance, and standard deviation using 

Excel functions (STDEV, VAR). 

*c. Calculate the correlation coefficient between 

two variables using the CORREL function 

✓ 
    

2 

*a. Construct a box plot using the Insert Chart 

feature to identify the median, quartiles, and 

outliers of a dataset. 

*b. Perform a simple linear regression analysis 

*c. Conduct a t-test to compare means between 

two groups 

*d. Calculate confidence intervals 

*e. Conduct a Chi-square test 

 
✓ 

   

3 

*Create a Data Table 

a. Import a sample dataset (e.g., sales data) into 

Excel. 

b. converts the dataset into an Excel Table using 

the "Format as Table" feature and apply 

appropriate styles. 

c. Create a dashboard sheet that summarizes key 

metrics (e.g., total sales, average sales per region) 

using tables. 

*Data Cleaning 

a. Identify and remove duplicates from a dataset. 

b. Use functions like TRIM, UPPER, LOWER, 

and PROPER to clean text data. 

c. Find and replace values using the Find & 

Replace feature. 

✓ ✓ ✓ 
  

4 

Create a Pivot Table 

a. A basic pivot table from a dataset 

b. Specify and filter data in a pivot table 
  

✓   
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c. Add a calculated field to a pivot table 

d. Group data within a pivot table. Refresh pivot 

table data after making changes to the source 

data. 

Filter and sort a PivotTable 

a. Apply a Filter to the PivotTable 

b. Sort Data in the Pivot Table. 

c. Add slicers to the PivotTable for interactive 

filtering. 

5 

Create a Pivot Chart 

a. A basic pivot chart from a dataset 

b. A dynamic pivot chart that updates based on 

user selection 

c. Group date items in a pivot table to summarize 

data by month or year 

d. Group product categories in a pivot table 

 
✓ ✓   

6 

*Create a Simple Chart 

a. A simple bar chart to visualize data sets 

b. A chart using non-adjacent cells to visualize 

data from different ranges. 

*Create a Chart Using the Chart Wizard 

a Select the chart you created and experiment  

with the Chart Tools options 

b. Modifying Charts 

c. Moving an Embedded Chart 

d. Sizing an Embedded Chart 

  
 ✓ 

 

7 

*Change the Chart Type 

a. Create a basic bar chart using a dataset and 

change its type to a different chart 

b. Experiment with different data display options, 

such as adding data labels, changing the axis 

format, and adjusting the gridlines 

c. Experiment with position and style of the 

legend 

  
 ✓ 

 

8 

a. Create a pie chart from a dataset 

b. Move the pie chart to a new worksheet for 

better visibility 

c. Emphasize a specific category by exploding a 

slice of the pie chart 

d. Customize the appearance of the pie chart for 

better presentation 

   
✓ 

 

9 

* Create different types of plots. Write a Python 

script to save the plot in different formats: PNG, 

PDF, and SVG. 
    

✓ 

10 
Application of data analytics across various 

industries through case study     
✓ 
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Guidelines to Teachers 

1. Teachers should align the explanation of the topic to teaching learning outcome 

(TLOs). 

2. Refer to laboratory learning outcome (LLOs) for the execution of the practical to focus 

on the defined objectives. 

3. Promote life-long learning by training the students to equip themselves with essential 

knowledge, skills and attitudes.   

4. If required, provide demonstration for the practical emphasizing on the skills that the 

student should achieve. 

5. Teachers should give opportunity to the students for exhibiting their skills after the 

demonstration. 

6. Provide feedback and/or suggestions and share insights to improve effectiveness. 

7. Assess students‘ skill achievement related to COs of each unit. 
 

 

Instructions for Students 

1. 100% attendance is compulsory for all practical sessions. 

2. Students must adhere to ethical practices. 

3. Plagiarism is strictly prohibited. 

4. Students should accomplish the requisites of Teamwork, Collaboration and Group 

Dynamics during the practical sessions. 

5. Students shall attempt to develop related hands on skills and gain confidence. 

6. All the students must follow the schedule of practical sessions, complete the assigned 

work/activity and submit the assignment in stipulated time as instructed by the course 

teacher. 

7. Follow formal attire and maintain personal appearance. 
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Content Page 

List of Practical and Formative Assessment Sheet 

Sr. 

No 
Practical Title 

Date of 

Performance 

Date of 

Submission 

Assessment 

Marks (25) 

Dated Sign 

of Teacher 

Remark 

(if any) 

1 

 *a. Calculate mean, median, 

and mode for a given dataset 

using Excel 

functions(AVERAGE, 

MEDIAN, MODE). 

*b. Calculate range, 

interquartile range 

(IQR),variance, and standard 

deviation using Excel 

functions (STDEV, VAR). 

*c. Calculate the correlation 

coefficient between two 

variables using the CORREL 

function 

     

2 

*a. Construct a box plot using 

the Insert Chart feature to 

identify the median, quartiles, 

and outliers of a dataset. 

*b. Perform a simple linear 

regression analysis 

*c. Conduct a t-test to 

compare means between two 

groups 

*d. Calculate confidence 

intervals 

*e. Conduct a Chi-square test 

     

3 

*Create a Data Table 

a. Import a sample dataset 

(e.g., sales data) into Excel. 

b. converts the dataset into an 

Excel Table using the 

"Format as Table" feature and 

apply appropriate styles. 

c. Create a dashboard sheet 

that summarizes key metrics 

(e.g., total sales, average sales 

per region) using tables. 

*Data Cleaning 

a. Identify and remove 

duplicates from a dataset. 
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b. Use functions like TRIM, 

UPPER, LOWER, and 

PROPER to clean text data. 

c. Find and replace values 

using the Find & Replace 

feature. 

4 

Create a Pivot Table 

a. A basic pivot table from a 

dataset 

b. Specify and filter data in a 

pivot table 

c. Add a calculated field to a 

pivot table 

d. Group data within a pivot 

table. Refresh pivot table data 

after making changes to the 

source data. 

Filter and sort a PivotTable 

a. Apply a Filter to the 

PivotTable 

b. Sort Data in the Pivot 

Table. 

c. Add slicers to the 

PivotTable for interactive 

filtering. 

     

5 

Create a Pivot Chart 

a. A basic pivot chart from a 

dataset 

b. A dynamic pivot chart that 

updates based on user 

selection 

c. Group date items in a pivot 

table to summarize data by 

month or year 

d. Group product categories 

in a pivot table 

     

6 

*Create a Simple Chart 

a. A simple bar chart to 

visualize data sets 

b. A chart using non-adjacent 

cells to visualize data from 

different ranges. 

*Create a Chart Using the 

Chart Wizard 

a Select the chart you created 

and experiment  with the 
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Chart Tools options 

b. Modifying Charts 

c. Moving an Embedded 

Chart 

d. Sizing an Embedded Chart 

7 

*Change the Chart Type 

a. Create a basic bar chart 

using a dataset and change its 

type to a different chart 

b. Experiment with different 

data display options, such as 

adding data labels, changing 

the axis format, and adjusting 

the gridlines 

c. Experiment with position 

and style of the legend 

     

8 

a. Create a pie chart from a 

dataset 

b. Move the pie chart to a 

new worksheet for better 

visibility 

c. Emphasize a specific 

category by exploding a slice 

of the pie chart 

d. Customize the appearance 

of the pie chart for better 

presentation 

     

9 

* Create different types of 

plots. Write a Python script to 

save the plot in different 

formats: PNG, PDF, and 

SVG. 

     

10 

Application of data analytics 

across various industries 

through case study 

     

    Total   

 

*Total marks to be transferred to proforma published by MSBTE 

Note: 

 '*' Marked Practicals (LLOs) are mandatory. 

 Minimum 80% of above list of lab experiment are to be performed. 

 Judicial mix of LLOs are to be performed to achieve desired outcome 
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Practical No. 1 

*a. Calculate mean, median, and mode for a given dataset using Excel functions (AVERAGE, 

MEDIAN, MODE). 

*b. Calculate range, interquartile range (IQR), variance, and standard deviation using Excel 

functions (STDEV, VAR). 

*c. Calculate the correlation coefficient between two variables using the CORREL function. 

I. Practical Significance 

Microsoft Excel is spreadsheet software developed by Microsoft used for organizing, 

analyzing, and visualizing data. Students will be able to understanding and analyzing numerical 

data using key Excel statistical functions. AVERAGE, MEDIAN, and MODE are used to 

identify central tendencies, while STDEV and VAR measure the spread or variability in the 

data. The CORREL function is used to examine the relationship between two variables. 

II. Industry / Employer Expected Outcome(s) 

Perform Data Analytics in various business domains for improved decision making 

III. Course Level Learning Outcomes(s) 

CO1 - Elaborate the fundamental concepts of Data Analytics. 

IV. Laboratory Learning Outcome(s) 

LLO 1.1 Perform Statistical Analysis in Excel. 

V. Relevant Affective Domain related Outcomes 

a. Follow precautionary measures. 

b. Follow naming conventions. 

c. Follow ethical practices 

VI. Relevant Theoretical Background 

 Microsoft Excel provides powerful tools like formulas, charts, and functions to perform 

calculations and automate tasks.  

a) AVERAGE, MEDIAN, and MODE Functions 

In Excel, functions like AVERAGE, MEDIAN, and MODE help summarize large amounts of 

numerical data. 

1. Mean (Average) 

Use the AVERAGE function: 

=AVERAGE(A1:A14) 

Example: Values: (2+1+5+6+3+1+2+3+4+5+6+7+8+9) / 14 = 72 / 14 = 5.14 

 

2. Median 

Use the MEDIAN function: 

=MEDIAN(A1:A14) 

This gives you the middle value when the numbers are sorted. 
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Example: Values: 1, 1, 2, 2, 3, 3, 4, 5, 5, 6, 6, 7, 8, 9 

    Middle two values (7th and 8th) = 4 and 5 

    Median = (4 + 5) / 2 = 4.5  

 

3. Mode 

Use the MODE.SNGL function (returns the most frequent value): 

=MODE.SNGL(A1:A14) 

If there are multiple modes and you want all of them, use: =MODE.MULT(A1:A14) 

Note: For MODE.MULT, select multiple cells first, then press Ctrl + Shift + Enter. 

Example: Values: 1, 1, 2, 2, 3, 3, 4, 5, 5, 6, 6, 7, 8, 9 

Values that appear twice: 1, 2, 3, 5, 6 

Excel returns the first mode it finds, which is 1 

b) Range, IQR , VAR and STDEV Functions 

Following functions helps to measure data spread. 

1. Range 

The range is the difference between the maximum and minimum values in a dataset. 

=MAX(A1:A7) - MIN(A1:A7) 

Example: If the values are 2, 1, 5, 6, 3, 1, 2, then:    Max = 6  and   Min = 1 

Range = 6 − 1 = 5 

 

2. IQR 

The Interquartile Range (IQR) is a measure of statistical dispersion, or in simpler 

terms, it tells us how spread out the middle 50% of values in a data set. 

Example: 

Use Excel‘s QUARTILE.INC function to calculate Q1and Q3.  

=QUARTILE.INC(A2:A11, 1) 

Where, A2:A11 is the range of data, and 1 represents the first quartile. 

=QUARTILE.INC(A2:A11, 3) 

Calculate the IQR by subtracting  Q1 from Q3=Q3 - Q1 

 

3. VAR 

Variance measures how far each number in the set is from the mean (average).A high 

variance means data points are spread out. A low variance means they are close to the 

mean. 

=VAR.S for Sample variance   

=VAR.P for Population Variance 

Example: If the values are 5,7,9,10,12  then  

Sample variance = 7.3 and 

Population Variance=5.84 

 

c) CORREL Function 

Excel‘s CORREL function can be used to identify  the relationship between two 

variables.  Value range: −1≤r≤1 ,     +1 = perfect positive correlation ,     0 = no correlation,     

−1 = perfect negative correlation 

Syntax in Excel : =CORREL(array1, array2) 

Example: 
=CORREL(A1:A5, B1:B5)  
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VII. Resources required (Additional) 

Sr. 

No. 

Name of Resource Broad Specification Quantity Remark (If Any) 

1 Computer System 

Computer (i5 

preferable), RAM 

minimum 8 GB 

onwards. Operating 

system: Windows 10 

onwards 

01 System for each 

Student 

 

2 Software 
Microsoft Office, 

Office 365- Excel 

VIII. Conclusion 

…………………………………………………………………………………………………….. 

…………………………………………………………………………………………………….. 

…………………………………………………………………………………………………….. 

IX. Practical related Questions 

Note: Below given are few sample questions for reference. Teachers must design more such 

questions to ensure the achievement of identified CO 

1. Find the median of this dataset using the MEDIAN function: 5, 8, 12, 14, 18 

2. Define mode. Can a dataset have more than one mode? 

3. Find the range of these numbers 25, 30, 35, 40, 45 

4. What is variance? What does it tell us about a dataset? 

5. Write the CORREL function to find the correlation between any two sets of 

numbers 

6. What does a correlation of 0 indicate about two variables? 

 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 
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…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 
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…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

X. References: 

1. https://www.simplilearn.com/tutorials/excel-tutorial/data-analysis-excel 

2. https://www.w3schools.com/excel/excel_functions.php 

  

XI. Assessment Scheme (25 Marks) 

 

S. No. Weightage- Process related: 60% Marks-15 

1. Logic formation:30%  

2. Debugging ability:20% 

3. Follow ethical practices:10% 

 Weightage- Product related: 40% Marks-10 

4. Expected output:15%  

5. Timely Submission:15% 

6. Answer to sample questions:10% 

 
Total 25 

 

  

Dated Signature of Course Teacher 

 

 

 

 

https://www.simplilearn.com/tutorials/excel-tutorial/data-analysis-excel
https://www.w3schools.com/excel/excel_functions.php
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Practical No. 2 

*a. Construct a box plot using the Insert Chart feature to identify the median, quartiles, and 

outliers of a dataset.  

*b. Perform a simple linear regression analysis 

*c. Conduct a t-test to compare means between two groups 

*d. Calculate confidence intervals 

*e. Conduct a Chi-square test 

I. Practical Significance 

Excel is spreadsheet software developed by Microsoft used for organizing, analyzing 

and visualizing data. The statistical techniques such as box plots, linear regression, t-tests, 

confidence intervals, and Chi-square tests help students and developers analyze performance 

trends, identify anomalies, and make informed decisions during software development and 

testing. 

II. Industry / Employer Expected Outcome(s) 

Perform Data Analytics in various business domains for improved decision making 

III. Course Level Learning Outcomes(s) 

CO2 - Apply appropriate statistical techniques to analyze and interpret complex Datasets 

IV. Laboratory Learning Outcome(s) 

LLO 2.1 Construct box plot. 

LLO 2.2 Perform the different types of function using linear regression. 

LLO 2.3 Perform T-test in Excel. 

LLO 2.4 Calculate confidence intervals for the mean of a dataset. 

LLO 2.5 Apply Chi-square test for independence 

V. Relevant Affective Domain related Outcomes 

d. Follow precautionary measures. 

e. Follow naming conventions. 

f. Follow ethical practices 

VI. Relevant Theoretical Background 

In real-world application development and academic training, statistical techniques 

play a critical role in evaluating and improving software performance and reliability. 

Theoretical foundations of these techniques include: 

a) Box Plot: A data visualization tool that shows the distribution of a dataset through 

quartiles, helping in identifying outliers in runtime, memory usage, etc. 

Steps:  

1. Select your data: Highlight the cells containing the values you want to plot.  

2. Go to Insert: On the Excel ribbon, click the "Insert" tab.  

3. Select Recommended Charts: Click the "Recommended Charts" button in the 

"Charts" group.  

4. Open All Charts: In the pop-up window, click the "All Charts" tab.  
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5. Choose Box & Whisker: Select "Box & Whisker" as the chart type.  

6. Confirm: Click "OK" to create the box plot. [Customize if needed: Under Customize, 

you can turn on labels for the median, quartiles, and outliers if they are not showing.] 

 

 

 

 

 

 

 

 

Fig: Box Plot 

b) Linear Regression: 

Linear regression in Excel is a statistical method used to model the relationship 

between two variables: An independent variable (X) — the predictor and A dependent 

variable (Y) i.e. the outcome.  

It fits a straight line (Y = mX + b) through your data, 

where: m is the slope (rate of change), b is the intercept (value of Y when X = 0). 

 

Steps: 

1. Enable the Data Analysis ToolPak: Go to File > Options > Add-Ins. Select "Excel Add-

ins" in the Manage list, and click "Go". Check the box for "Analysis ToolPak" and click 

OK.  

2. Open Data Analysis: On the Data tab, click "Data Analysis".  

3. Select Regression: Choose "Regression" from the list of analysis tools and click "OK".  

4. Input Ranges: Specify the Input Y Range (dependent variable) and Input X Range 

(independent variable(s)). You can also specify the output range for the regression 

results.  

5. Configure Settings: You can choose to display labels, have the output on a new sheet, 

and specify other options.  

6. Run the Analysis: Click "OK" to generate the regression output. 

 

 

Fig: Linear Regression 
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c) T-Test:  

A hypothesis test used to compare the means of two groups, e.g. comparing 

execution times between Eclipse and Net Beans. 

 
where, x1,x2 = sample means; s1

2
,s2

2
 = sample variances; n1,n2 = sample sizes 

Excel Formula for T-Test: 

=T.TEST(array1, array2, tails, type) 

 

Fig: T –Test to compare two means 

d) Confidence Interval:  

Provides a range in which the true metric (like average runtime) is expected to 

fall, enhancing decision-making with uncertainty estimates.  

Excel Formula for Confidence Interval: 

a. For Known Standard Deviation  

=CONFIDENCE.NORM(alpha, standard_dev, size) 

b. For Unknown Standard Deviation  

=CONFIDENCE.T(alpha, standard_dev, size) 

 

 

Fig: Confidence Interval 

e) Chi-square Test: 

 The Chi-square (χ²) test is a statistical method used in data analytics to examine the 

relationship between categorical variables. A test that measures how a model compares 

to actual observed data can be calculated using: 

          χ
2 

= ∑   (O−E)
2  

      where, O is Observed Value , E is Expected Value 

                                      E 
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Degrees of Freedom:S 

df = (r − 1) (c − 1)          where, r is no of rows, c is no of columns 

Excel Formula for Chi Square Test: 

=CHISQ.TEST(actual_range, expected_range) 

 
Fig: Chi-Square Test 

VII. Resources required (Additional) 

Sr. 

No. 

Name of Resource Broad Specification Quantity Remark (If Any) 

1 Computer System 

Computer (i5 

preferable), RAM 

minimum 8 GB 

onwards. Operating 

system: Windows 10 

onwards 

01 System for 

each Student 

 

2 Software 
Microsoft Office, 

Office 365- Excel 

VIII. Conclusion 

…………………………………………………………………………………………………….. 

…………………………………………………………………………………………………….. 

…………………………………………………………………………………………………….. 

IX. Practical related Questions 

Note: Below given are few sample questions for reference. Teachers must design more such 

questions to ensure the achievement of identified CO 

1. Define Median, Quartiles and outliers of a dataset. 

2. Create a box plot in Excel using the following dataset of student test scores: 

78, 85, 88, 92, 67, 73, 85, 90, 95, 100. 

3. What is Degrees of Freedom and how it is calculated? 

4. What‟s the difference between linear regression and logistic regression? 

5. Two sets of students took different versions of a quiz.  

Group A scored:72, 75, 78, 74, 70 and Group B scored: 68, 65, 70, 67, 66. 

Use Excel‟s T.TEST function to determine if there is a significant difference between 

the groups 
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6. Conduct a Chi-Square test for given data: 

 
 

 Satisfied Neutral Dissatisfied  Total 

Sales 15 10 5 30 

IT 10 15 5 30 

HR 5 5 20 30 

Total 30 30 30 90 

 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 
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…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 
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…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

X. References: 

1. https://www.w3schools.com/datascience/ds_linear_regression.asp 

2. https://www.datacamp.com/tutorial/chi-square-test-in-spreadsheets 

3. https://support.microsoft.com/en-us/office/t-test-function-d4e08ec3-c545-485f-962e-

276f7cbed055 

4. https://www.datacamp.com/tutorial/how-to-calculate-confidence-intervals-in-excel 

 

XI. Assessment Scheme (25 Marks) 

 

S. No. Weightage- Process related: 60% Marks-15 

1. Logic formation:30%  

2. Debugging ability:20% 

3. Follow ethical practices:10% 

 Weightage- Product related: 40% Marks-10 

4. Expected output:15%  

5. Timely Submission:15% 

6. Answer to sample questions:10% 

 
Total 25 

 

  

Dated Signature of Course Teacher 

 

 

 

 

https://www.w3schools.com/datascience/ds_linear_regression.asp
https://www.datacamp.com/tutorial/chi-square-test-in-spreadsheets
https://support.microsoft.com/en-us/office/t-test-function-d4e08ec3-c545-485f-962e-276f7cbed055
https://support.microsoft.com/en-us/office/t-test-function-d4e08ec3-c545-485f-962e-276f7cbed055
https://www.datacamp.com/tutorial/how-to-calculate-confidence-intervals-in-excel
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Practical No. 3 

*Create a Data Table: 

a. Import a sample dataset (e.g., sales data) into Excel. 

b. Converts the dataset into an Excel Table using the "Format as Table" feature and apply 

appropriate styles. 

c. Create a dashboard sheet that summarizes key metrics (e.g., total sales, average sales per 

region) using tables. 

 

*Data Cleaning 

a. Identify and remove duplicates from a dataset. 

b. Use functions like TRIM, UPPER, LOWER, and PROPER to clean text data. 

c. Find and replace values using the Find & Replace feature. 

I. Practical Significance 

This practical focuses on data organization, cleaning, and summarization using Excel. 

Data cleaning techniques, including identifying duplicates and using functions like TRIM, 

UPPER, and PROPER, ensure that the data is consistent and ready for analysis. Students will 

be able to managing and preparing data in fields such as business analysis, marketing, and 

finance.   

II. Industry / Employer Expected Outcome(s) 

Perform Data Analytics in various business domains for improved decision making 

III. Course Level Learning Outcomes(s) 

CO3 - Analyze numerical data by creating pivot table. 

IV. Laboratory Learning Outcome(s) 

LLO 3.1 Create a table to execute the function using dashboard. 

LLO 3.2 Perform various operations for data cleaning.. 

V. Relevant Affective Domain related Outcomes 

g. Follow precautionary measures. 

h. Follow naming conventions. 

i. Follow ethical practices 

VI. Relevant Theoretical Background 

1. Create a Data table: 

a) Import a Sample Dataset (e.g., Sales Data) in to Excel: 

Steps: 

1. If you have a CSV( comma separated Values )  or Excel file, download and save it to 

your computer. 

2. You can create a sample sales dataset manually with columns like Date, Product, 

Region, Sales Amount, Quantity Sold. 
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b) Convert the Dataset into an Excel Table: 

Steps: 

1. Click anywhere inside your dataset. 

2. Press Ctrl + A to select the full range (or manually highlight it). 

3. Go to the Home tab and select Format as Table. 

4. Choose a style that suits your report. 

5. Ensure the "My table has headers" option is checked. 

6. Click OK, and your data will be converted into an Excel Table. 

 

c) Create a Dashboard Sheet for Key Metrics: 

Steps: 

1. Click the + button at the bottom to add a new worksheet. 

2. Rename it to “Dashboard” (optional but recommended for clarity). 
3. Click anywhere inside the table. 
4. Go to the Insert tab → Pivot Table → Select the Table range and click OK. 

5. Ensure the Table/Range is selected (e.g., Table1). 

6. Choose to place the PivotTable in the new Dashboard sheet with valid cell and click 

OK. 

7. Drag fields to summarize key metrics like Total Sales, Average Sales Per Region, Best-

Selling Products. 

[Note: Students can create dashboard without using pivot table and by using formulas] 

2. Data Cleaning: 

a) Identify and Remove Duplicates: 

Steps: 

1. Click anywhere inside your dataset. 

2. Press Ctrl + A to select the full range (or manually highlight the column/rows to check 

for duplicates). 

3. Go to the Data tab and select Remove Duplicates. 

4. A dialog box will appear—choose the columns where duplicates should be checked. 

5. Click OK, and Excel will remove the duplicate values. 

6. A message will appear showing how many duplicates were removed and how many 

unique values remain. 

b) Use functions to clean text data: 

Steps: 

1. Use the TRIM Function (Removes Extra Spaces) 

Example: ―         abc‖ 

=TRIM(―          abc‖) 

Output: ―abc‖ 

2. Convert Text Case Using UPPER, LOWER, and PROPER 

Example: ―abcd‖ 

=UPPER(―abcd‖) 

Output: ―ABCD‖ 

Example: ―Hello World‖ 
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=LOWER(―Hello World‖) 

Output: ―hello world‖ 

 

Example: ―heLlo WoRld‖ 

=PROPER(―Hello World‖) 

Output: ―Hello World‖ 

 

c) Find and replace values: 

Steps: 

1. Press Ctrl + H or go to Home → Find & Select → Replace. 

2. In the Find What box, enter the value you want to find. 

a. In the Replace With box, enter the new value. 

b. Click Replace All to apply changes throughout the dataset. 

c. Review the modified dataset to ensure accuracy. 

VII. Resources required (Additional) 

Sr. 

No. 

Name of Resource Broad Specification Quantity Remark (If Any) 

1 Computer System 

Computer (i5 

preferable), RAM 

minimum 8 GB 

onwards. Operating 

system: Windows 10 

onwards 

01 System for each 

Student 

 

2 Software 
Microsoft Office, 

Office 365- Excel 

VIII. Conclusion 

…………………………………………………………………………………………………….. 

…………………………………………………………………………………………………….. 

…………………………………………………………………………………………………….. 

IX. Practical related Questions 

Note: Below given are few sample questions for reference. Teachers must design more such 

questions to ensure the achievement of identified CO 

1. How does converting a dataset into an Excel Table improve data organization and 

analysis? 

2. Use TRIM, PROPER, LOWER functions and Remove Duplicates to clean text data 

for Customer Name and Email Id (Consider any sample dataset)? 

3. Perform following with given dataset:  

a. Use Find & Replace to correct the typo "Stationary" → "Stationery".  

b. Use UPPER to convert all product names to uppercase.  

c. Remove any duplicate product entries. 
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Product      Category     Price  

 Pen          Stationery  1.5 

 Pencil       Stationary  1 

 Eraser       Stationery  0.5 

 Marker Pen   Stationary  2 

 Pen          Stationery  1.5 

 

4. Create a dashboard sheet that summarizes key metrics for Class Test Report with 

student Name, all Subject marks, Total and Percentage.  

 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 
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…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 
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…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

 

X. References: 

1.  https://spreadsheetpoint.com/excel/dashboard-in-excel/ 

2. https://www.javatpoint.com/how-to-create-a-dashboard-in-excel 

3. https://www.ablebits.com/office-addins-blog/data-table-excel-one-variable-two-variable/ 

4. https://www.geeksforgeeks.org/top-5-excel-data-cleaning-techniques-to-know-in-2023/ 

 

XI. Assessment Scheme (25 Marks) 

 

S. No. Weightage- Process related: 60% Marks-15 

1. Logic formation:30%  

2. Debugging ability:20% 

3. Follow ethical practices:10% 

 Weightage- Product related: 40% Marks-10 

4. Expected output:15%  

5. Timely Submission:15% 

6. Answer to sample questions:10% 

 
Total 25 

 

  

Dated Signature of Course Teacher 

 

 

 

 

 

https://spreadsheetpoint.com/excel/dashboard-in-excel/
https://www.javatpoint.com/how-to-create-a-dashboard-in-excel
https://www.ablebits.com/office-addins-blog/data-table-excel-one-variable-two-variable/
https://www.geeksforgeeks.org/top-5-excel-data-cleaning-techniques-to-know-in-2023/
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Practical No. 4 

Create a Pivot Table 

a. A basic pivot table from a dataset 

b. Specify and filter data in a pivot table 

c. Add a calculated field to a pivot table 

d. Group data within a pivot table. Refresh pivot table data after making changes to the 

source data. 

 

Filter and sort a PivotTable 

a. Apply a Filter to the PivotTable 

b. Sort Data in the Pivot Table. 

c. Add slicers to the PivotTable for interactive filtering. 

I. Practical Significance 

Pivot tables allow students to summarize large datasets efficiently, turning raw 

numbers into meaningful insights. Students with Excel skills have a competitive edge when 

applying for internships and jobs. Filtering and sorting allow students to quickly locate specific 

information in massive datasets. 

II. Industry / Employer Expected Outcome(s) 

Perform Data Analytics in various business domains for improved decision making 

III. Course Level Learning Outcomes(s) 

CO3 - Analyze numerical data by creating pivot table. 

IV. Laboratory Learning Outcome(s) 

LLO 4.1 Create a pivot table to analyze the data set. 

LLO 4.2 Sort and filter the given dataset. 

V. Relevant Affective Domain related Outcomes 

a. Follow precautionary measures. 

b. Follow naming conventions. 

c. Follow ethical practices 

VI. Relevant Theoretical Background 

Pivot Table : 

 A pivot table is a powerful tool used in spreadsheets (like Excel, Google Sheets) to 

summarize, analyze, and organize data efficiently. It helps in transforming raw data into 

meaningful insights by allowing users to rearrange and compare information dynamically. 

Adding calculated fields enhances the analysis with custom metrics, and grouping data 

provides insights into patterns. Creating a PivotTable allows for quick aggregation and 

analysis, while filtering and sorting help focus on specific data points. 
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1. Create a Pivot Table: 

a) A basic pivot table from a dataset: 

Steps: 

1. Open your Excel file containing the data. 

2. Select any cell within your dataset. 

3. Go to Insert → Click PivotTable. 

 

 
Fig: Inserting Pivot Table 

 

4. Choose whether to place the PivotTable in a new worksheet or an existing one. 

5. Click OK—your blank PivotTable is now ready. 

6. Use the PivotTable Fields pane to drag fields into Rows, Columns, Values, and Filters. 

b) Specify and filter data in a pivot table: 

Steps: 

 

1. After creating the PivotTable, drag data fields into the Filters section. 

2. Click the drop-down arrow in the Filter field and select specific items to display. 

3. To remove filters, click Clear Filter in the filter menu. 

c) Add a calculated field to a pivot table 

Steps: 

 

1. Click any cell inside the PivotTable. 

2. Go to PivotTable Analyze → Click Fields, Items & Sets → Select Calculated Field. 

3. In the Insert Calculated Field dialog box: 

a. Enter a name for the field. 

b. Define a formula (e.g., =Sales * 1.1 for a 10% increase in Sales). 

4. Click OK, and the new calculated field will appear in the PivotTable. 



  

Data Analytics Course Code: 315326 

 

Maharashtra State Board of Technical Education ( ‗K‘ Scheme)                    21  

d) Group data within a pivot table. Refresh pivot table data after making changes to the 

source data. 

Steps: 

 

1. Select the data you want to group (e.g., dates or categories). 

2. Right-click → Choose Group. 

 
Fig: Grouping data in Pivot Table 

3. Set group parameters (e.g., grouping by months or quarters for dates). 

4. Click OK—your grouped data appears in the PivotTable. 

5. Modify your original dataset. 

6. Click inside the PivotTable. 

7. Go to PivotTable Analyze → Click Refresh. 

2. Filter and Sort a Pivot Table 

a) Apply a Filter to the Pivot table  

Steps: 

1. Click the drop-down arrow in the PivotTable Filter section. 

2. Select or deselect values to display specific information. 

b) Sort Data in the Pivot Table 

Steps: 

1. Click any column header inside the PivotTable. 

2. Go to Sort & Filter → Click Ascending or Descending. 

c) Add Slicers for Interactive Filtering 

Steps: 

1. Click inside the PivotTable. 

2. Go to PivotTable Analyze → Click Insert Slicer. 
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Fig: Inserting Slicer 

3. Select the field(s) you want to filter. 

4. Click OK—the slicer buttons appear for quick filtering  

VII. Resources required (Additional) 

Sr. 

No. 

Name of Resource Broad Specification Quantity Remark (If Any) 

1 Computer System 

Computer (i5 

preferable), RAM 

minimum 8 GB 

onwards. Operating 

system: Windows 10 

onwards 

01 System for each 

Student 

 

2 Software 
Microsoft Office, 

Office 365- Excel 

VIII. Conclusion 

…………………………………………………………………………………………………….. 

…………………………………………………………………………………………………….. 

…………………………………………………………………………………………………….. 

IX. Practical related Questions 

Note: Below given are few sample questions for reference. Teachers must design more such 

questions to ensure the achievement of identified CO 

 

1. What are the benefits of using pivot tables? 
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2. How do you create calculated fields in a pivot table write steps with any data set? 
3. What are the total sales of each product by region for following data set 

 

4. Create slicers for given dataset in Q.2 and write how do they work? 

5. Perform filtering, sorting and Grouping for given pivot table. 

Student   Division   Subject   Marks  

 Ananya    A          Math     85 

 Bina  A          Science  78 

 Chetan   B          Math     92 

 Dinash  B          Science  88 

 Esha      A          Math     90 

 Fareeha     B          Math     75 

 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

Date Region Product Sales 

2025-01-01 East Apple 100 

2025-01-01 East Banana 150 

2025-01-02 West Apple 200 

2025-01-02 West Banana 120 

2025-01-03 East Apple 130 

2025-01-03 West Banana 170 
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…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 
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…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

X. References: 

1. https://www.w3schools.com/excel/excel_table_pivot_intro.php 

2. https://www.geeksforgeeks.org/pivot-tables-in-excel/  

 

XI. Assessment Scheme (25 Marks) 

 

S. No. Weightage- Process related: 60% Marks-15 

1. Logic formation:30%  

2. Debugging ability:20% 

3. Follow ethical practices:10% 

 Weightage- Product related: 40% Marks-10 

4. Expected output:15%  

5. Timely Submission:15% 

6. Answer to sample questions:10% 

 
Total 25 

 

  

Dated Signature of Course Teacher 

 

 

 

 

 

 

 

 

 

https://www.w3schools.com/excel/excel_table_pivot_intro.php
https://www.geeksforgeeks.org/pivot-tables-in-excel/
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Practical No. 5 

Create a Pivot Chart 

a. A basic pivot chart from a dataset 

b. A dynamic pivot chart that updates based on user selection 

c. Group date items in a pivot table to summarize data by month or year. 

d. Group product categories in a pivot table 

I. Practical Significance 

Pivot charts are incredibly useful for students, especially those working with large sets 

of data. Students in business, finance, or statistics can use pivot charts to spot trends and make 

informed conclusions. Students will be able to Creating a basic PivotChart allows for graphical 

analysis of key metrics, while dynamic charts that update based on user selection provide 

interactive data exploration.. 

II. Industry / Employer Expected Outcome(s) 

Perform Data Analytics in various business domains for improved decision making 

III. Course Level Learning Outcomes(s) 

CO3 - Analyze numerical data by creating pivot table. 

IV. Laboratory Learning Outcome(s) 

LLO 5.1 Customize your chart with titles, labels, colors, and legends as desired. 

V. Relevant Affective Domain related Outcomes 

a. Follow precautionary measures. 

b. Follow naming conventions. 

c. Follow ethical practices 

VI. Relevant Theoretical Background 

A Pivot Chart in Excel is a powerful tool for data analytics that helps users visualize 

and analyze large datasets dynamically. It works alongside Pivot Tables, enabling users to 

present complex data in an interactive and customizable format. 

Example: Imagine a student analyzing sales data over different quarters. Instead of going 

through rows of numbers, a Pivot Chart can instantly show trends like seasonal spikes or 

product popularity changes. 

a) A basic pivot chart from a dataset 

Steps: 

1. Open your Excel file and select your dataset. 

2. Go to the Insert tab and click on PivotTable. 

3. Choose where you want to place the PivotTable (New Worksheet or Existing 

Worksheet) and click OK. 

4. Drag fields to the Rows and Values sections to organize your data. 

5. Click anywhere inside the PivotTable, then go to the Insert tab and select PivotChart. 
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6. Choose your desired chart type and click OK—your Pivot Chart is now ready. 

 

 
Fig: Inserting Pivot Chart 

b) A dynamic pivot chart that updates based on user selection 

Steps: 

1. Create a PivotTable as described above. 

2. Click inside the PivotTable, then go to the PivotTable Analyze tab. 

3. Select Insert Slicer and choose the fields users can filter dynamically. 

4. Position the slicers next to the Pivot Chart for interactive data selection. 

5. Adjust the Pivot Chart as needed—any changes in the slicers will automatically update 

the chart. 

 
Fig: Inserting Slicer in Pivot Chart 

 

c) Group date items in a pivot table to summarize data by month or year 

Steps: 

1. Create a PivotTable and include a column with date values. 

2. Click on any date field inside the PivotTable. 
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3. Go to the PivotTable Analyze tab and select Group Field. 

4. In the Grouping box, select the time intervals (Months, Quarters, Years) you want. 

5. Click OK—your date values are now grouped for easier analysis. 

d) Group product categories in a pivot table 

Steps: 

1. Set up a PivotTable with product names in the Rows section. 

2. Select multiple product names you want to group. 

3. Right-click and choose Group—Excel will create a new group automatically. 

4. Rename the grouped field for clarity. 

5. Your PivotTable now organizes products by category, making analysis easier   

 

 
Fig: Grouping in Pivot Table 

VII. Resources required (Additional) 

Sr. 

No. 

Name of Resource Broad Specification Quantity Remark (If Any) 

1 Computer System 

Computer (i5 

preferable), RAM 

minimum 8 GB 

onwards. Operating 

system: Windows 10 

onwards 

01 System for 

each Student 

 

2 Software 
Microsoft Office, 

Office 365- Excel 

VIII. Conclusion 

…………………………………………………………………………………………………….. 

…………………………………………………………………………………………………….. 

…………………………………………………………………………………………………….. 
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IX. Practical related Questions 

Note: Below given are few sample questions for reference. Teachers must design more such 

questions to ensure the achievement of identified CO 

1. Create a basic pivot chart to visualize sales by region and product type, for given 

dataset in Excel? 

Region Product Type Sales 

North Electronics 1000 

South Electronics 1200 

North Furniture 800 

South Furniture 950 

2. Create a dynamic pivot chart that filters data based on a dropdown list on a 

separate worksheet? 

3. How would you group specific dates or values in a pivot chart (e.g., group years 

into decades) Perform and write steps? 

4. Change the chart type or style of a pivot chart and write steps? 

5. How can you summarize this in Excel using a Pivot Table with date grouping? 

Date Product Sales 

21/1/2023 Laptop 1000 

15/2/2023 Phone 800 

21/3/2024 Tablet 900 

19/4/2024 Phone 700 

29/5/2025 Laptop 1100 

 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 
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…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

X. References: 

1. https://www.excel-easy.com/examples/pivot-chart.html  

2. https://support.microsoft.com/en-us/office/create-a-pivotchart-c1b1e057-6990-4c38-b52b-

8255538e7b1c  

3. https://www.ablebits.com/office-addins-blog/pivot-charts-excel/  

 

XI. Assessment Scheme (25 Marks) 

 

S. No. Weightage- Process related: 60% Marks-15 

1. Logic formation:30%  

2. Debugging ability:20% 

3. Follow ethical practices:10% 

 Weightage- Product related: 40% Marks-10 

4. Expected output:15%  

5. Timely Submission:15% 

6. Answer to sample questions:10% 

 
Total 25 

 

  

Dated Signature of Course Teacher 

 

 

 

 

 

https://www.excel-easy.com/examples/pivot-chart.html
https://support.microsoft.com/en-us/office/create-a-pivotchart-c1b1e057-6990-4c38-b52b-8255538e7b1c
https://support.microsoft.com/en-us/office/create-a-pivotchart-c1b1e057-6990-4c38-b52b-8255538e7b1c
https://www.ablebits.com/office-addins-blog/pivot-charts-excel/
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Practical No. 6 

*Create a Simple Chart 

a. A simple bar chart to visualize data sets 

b. A chart using non-adjacent cells to visualize data from different ranges. 

 

*Create a Chart Using the Chart Wizard 

a. Select the chart you created and experiment with the Chart Tools options 

b. Modifying Charts 

c. Moving an Embedded Chart 

d. Sizing an Embedded Chart 

I. Practical Significance 

Creating a simple chart offers practical benefits by visually summarizing data, making it 

easier to understand complex information and identify trends. Charts can simplify data, 

enhance clarity, and improve communication by presenting information in a more accessible 

and memorable format. This is especially useful for situations where large amounts of data 

need to be conveyed quickly and effectively.  

The Chart Wizard simplifies the creation of charts and allows users to focus on effective 

data presentation. Since version 8.0 ONLYOFFICE Spreadsheet Editor comes with the Chart 

Wizard feature that displays a list of the recommended chart types and a preview for all types 

of charts based on the selected data. 

II. Industry / Employer Expected Outcome(s) 

Perform Data Analytics in various business domains for improved decision making 

III. Course Level Learning Outcomes(s) 

CO4 - Represent data in terms of various types of charts. 

IV. Laboratory Learning Outcome(s) 

LLO 6.1 Create a simple chart to visualize the data sets. 

V. Relevant Affective Domain related Outcomes 

a. Follow precautionary measures. 

b. Follow naming conventions. 

c. Follow ethical practices 

VI. Relevant Theoretical Background 

a. A simple bar chart to visualize data sets 

To create a simple bar chart, gather your data, draw or select axes, label them 

appropriately, and then draw bars representing the values of each category. You can then 

interpret the data by comparing the lengths of the bars. 
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 Steps to Create a Bar Chart:  

1. Collect Data: Gather the data you want to visualize, such as sales figures, customer 

demographics, or experimental results. 

2. Draw or Select Axes: A bar chart typically has two axes: the x-axis (horizontal) 

and the y-axis (vertical). 

3. Label the Axes: Clearly label the x-axis with the categories or groups you want to 

represent and label the y-axis with the units of measurement (e.g., sales in dollars, 

number of customers). 

4. Draw the Bars: Draw vertical (or horizontal) bars for each category. The height (or 

length) of each bar should be proportional to the corresponding value in your data. 

5. Interpret the Data: Once the bar chart is complete, you can compare the heights 

(or lengths) of the bars to visually see the relationships and differences between the 

data categories. 

b. A chart using non-adjacent cells to visualize data from different ranges 

To create a chart using non-adjacent cells in Excel, select the first set of cells, hold 

down the Ctrl key (or Cmd key on Mac), and then select the additional non-adjacent cells or 

ranges. Once all the data is selected, you can then insert a chart as you normally would. Here's 

a more detailed breakdown: 

1. Select the First Range: Choose the first set of cells containing the data you want to 

include in your chart. 

2. Hold Ctrl (or Cmd): Press and hold down the Ctrl key on your keyboard (or Cmd 

on a Mac).  

3. Select Additional Ranges: While holding Ctrl (or Cmd), click and select any other 

non-adjacent cells or ranges that you want to include in your chart.  

4. Insert Chart: Go to the "Insert" tab on the Excel ribbon and choose the desired 

chart type.  

5. Customize: You can then customize the chart as needed, such as adding titles, 

labels, and formatting the chart elements. 

*Create a Chart Using the Chart Wizard  

Following steps should be followed while creating a chart using the Chart Wizard: 

1. Select your data: Highlight the cells containing the data you want to include in the 

chart. 

2. Initiate the Chart Wizard: Click the "Insert Chart" or similar button (often located 

on the Insert tab… Click the "Insert" tab and select "Recommended Charts" or 

"Chart" depending on your Excel version. The Chart Wizard will open.). 

3. Choose a chart type: The Chart Wizard will present a variety of chart types (e.g., 

column, bar, pie, line). Select the one that best represents your data. 

4. Customize elements: The Chart Wizard may allow you to adjust data ranges, 

labels, axes, and other chart elements. 

5. Place the chart: The wizard will then create the chart and place it on your 

worksheet.  
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*Using Chart Tools (or similar): 

1. Select the chart: Click on the chart to make it active and display the Chart Tools 

ribbon (or similar). 

2. Explore formatting options: The Chart Tools ribbon will provide options for 

customizing the chart's appearance, including colors, fonts, labels, and other 

elements. 

3. Experiment with layouts: You can change the layout of the chart, including the 

position of the title, legend, and axes. 

4. Refine chart elements: Modify the chart's elements, such as changing the chart type, 

adding or removing labels, or adjusting the scale of the axes. 

*Modifying Charts: 

1. Change chart type: Right-click on the chart and select "Change Chart Type" to 

switch to a different visualization. 

2. Add/remove chart elements: Use the Chart Tools contextual tabs ("Design" and 

"Format") to add or remove elements like titles, axis labels, gridlines, trendlines, and 

error bars. 

3. Format chart appearance: Within the Chart Tools, modify the chart's colours, fonts, 

styles, and layout to enhance its visual appeal. 

4. Update data: If the source data changes, the chart will automatically update. You 

can also manually refresh the chart by selecting "Data" from the Chart Tools ribbon. 

*Moving an Embedded Chart: 

1. Click and drag: Simply click and hold the chart title or border and drag it to the 

desired location within the worksheet. 

*Sizing an Embedded Chart: 

1. Resize handles: Hover over the chart's edges until resize handles appear (small 

squares). Click and drag these handles to adjust the chart's width and height. 

2. Specific size: Right-click the chart, select "Format Chart Area," and specify the exact 

dimensions in the "Size" tab. 

VII. Resources Required  

Sr. 

No. 

Name of Resource Broad Specification Quantity Remark (If Any) 

1 Computer System 

Computer (i5 

preferable), RAM 

minimum 8 GB 

onwards. Operating 

system: Windows 10 

onwards 

01 System for each 

Student 

 

2 Software 
Microsoft Office, 

Office 365- Excel 

 



  

Data Analytics Course Code: 315326 

 

Maharashtra State Board of Technical Education ( ‗K‘ Scheme)                    36  

VIII. Conclusion 

…………………………………………………………………………………………………….. 

…………………………………………………………………………………………………….. 

…………………………………………………………………………………………………….. 

IX. Practical Related Questions 

Note: Below given are few sample questions for reference. Teachers must design more such 

questions to ensure the achievement of identified CO. 

1. What are the key points about Embedded Charts? 

2. How do you change the chart‟s axis range to display a specific subset of data? 

3. Consider your company C wants to visualize its market share compared to 

competitors (Company X, Y, and Z) over the last year so visualize this using a bar 

chart, and also explain why is it the best chart type for this data? 

4. Create a chart that compares annual revenue (from one range of cells) and annual 

expenses (from another non-adjacent range) for your company X as well as create 

a chart that visualizes both these data sets in one chart? 

5. Create a chart that represents the pass percentage of the students by year wise. 

(Consider your department data). 

6. Create a spreadsheet with sales data for different products over several months 

and create a bar chart using the Chart Wizard. 

7. Consider you have data on sales figures for different products. You could use the 

Chart Wizard to create a bar chart, where each bar represents a product's sales. 

Then, using Chart Tools, perform the following task :-   

a) Add a title like "Product Sales". 

b) Add a legend to identify each bar. 

c) Change the color of the bars to make them visually appealing. 

d) Add data labels to display the actual sales figures on each bar. 

e) Adjust the layout to make the chart more readable and visually pleasing. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 
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…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 
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…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

X. References: 

1. https://www.geeksforgeeks.org/charts-and-graphs-for-data-visualization/?ref=asr3 

2.  https://www.selfstudys.com/uploads/pdf/RltDCxKHwA5qkZv8Hk9e.pdf 

3.  https://www.extendoffice.com/documents/excel/2217-excel-chart-data-non-

contiguous.html 

XI. Assessment Scheme (25 Marks) 

S. No. Weightage- Process related: 60% Marks-15 

1. Logic formation:30%  

2. Debugging ability:20% 

3. Follow ethical practices:10% 

 Weightage- Product related: 40% Marks-10 

4. Expected output:15%  

5. Timely Submission:15% 

6. Answer to sample questions:10% 

 
Total 25 

 

  

Dated Signature of Course Teacher 

 

https://www.geeksforgeeks.org/charts-and-graphs-for-data-visualization/?ref=asr3
https://www.selfstudys.com/uploads/pdf/RltDCxKHwA5qkZv8Hk9e.pdf
https://www.extendoffice.com/documents/excel/2217-excel-chart-data-non-contiguous.html
https://www.extendoffice.com/documents/excel/2217-excel-chart-data-non-contiguous.html
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Practical No. 7  

*Change the Chart Type 

a. Create a basic bar chart using a dataset and change its type to a different chart 

b. Experiment with different data display options, such as adding data labels, changing the axis 

format, and adjusting the gridlines 

c. Experiment with position and style of the legend 

I. Practical Significance 

Changing the chart type, adjusting data display options, and experimenting with the 

legend position and style are all crucial aspects of data visualization, as they significantly 

impact how effectively your audience interprets and understands the information presented. 

II. Industry / Employer Expected Outcome(s) 

Perform Data Analytics in various business domains for improved decision making 

III. Course Level Learning Outcomes(s) 

CO4 - Represent data in terms of various types of charts. 

IV. Laboratory Learning Outcome(s) 

LLO 7.1 Change the chart type with adding data labels, axis format, and adjusting the gridlines. 

V. Relevant Affective Domain related Outcomes 

a. Follow precautionary measures. 

b. Follow naming conventions. 

c. Follow ethical practices 

VI. Relevant Theoretical Background 

1. Create a basic bar chart: 

 Input your data: Enter your data into a spreadsheet. This should include categories on   

one axis (x-axis) and values on the other (y-axis). 

 Select the data: Highlight the cells containing your data.  

 Insert a chart: Go to the "Insert" tab in your spreadsheet software and click on 

"Column" or "Bar" to create a basic bar chart.  

2. Change the chart type: 

 Click the chart: Select the bar chart you just created.  

 Access the chart options: Depending on your software, there are usually multiple ways 

to access the chart modification options. You can right-click on the chart, click the 

"Chart" or "Design" tab, or click a dedicated "Chart Options" button.  
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Change the chart type: In the chart options panel, look for an option to "Change Chart 

Type," "Select Chart Type," or similar. Choose a different chart type, such as a line 

chart, pie chart, or scatter plot, depending on what best represents your data. 

3. Experiment with data display options: 

 Add data labels: Select the chart. Access the chart options (see step 2). Look for an 

option related to "Data Labels," "Series Labels," or "Values." Choose where you want 

the labels to appear (above, below, inside the bars, etc.) and customize their appearance 

(font, size, colour).  

 Change the axis format: 

 Axis Titles: Add clear titles to your x and y axes to explain what they represent. 

 Axis Scale: Adjust the minimum and maximum values on the axes to better fit 

your data. You might need to zoom in or out to make the trends clearer.  

 Gridlines: Decide whether to show gridlines on the chart and, if so, how 

frequently they should appear.  

 Chart Title: Add a clear and concise title to your chart.  

4. Experiment with legend position and style: 

 Add a chart legend: Click the chart to which you want to add a legend, click the Chart 

Elements button, and then click Legend. To change the location of the legend, click the 

arrow next to Legend and then click the location that you want. 

 

Fig: Add a chart legend 

 Format a chart legend: Once you add the chart legend, there are many things that you 

can do to change how it looks.  

 Change font or font size: Right-click the legend, and then click Font. 
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Fig: Change font or font size 

 On the Font tab, make the changes that you want to the font or font size. 

 Change legend border or background 

 Right-click the legend, and then click Format Legend. 

 In the Format Legend task pane, pick the options that you want. 

 Overall, you can perform following steps: - 

 Show/Hide the legend: You can choose to display the legend or hide it. If displayed, 

you can control its: 

 Position: Place the legend above, below, to the side, or within the chart. 

 Style: Change the legend's text colour, font, and background. You might also want to 

the legend entries to make them clearer (e.g., using shorter labels or icons). 

VII. Resources Required  

Sr. 

No. 

Name of 

Resource 

Broad Specification Quantity Remark (if any) 

1 

Computer 

System 

Computer (i5 preferable), 

RAM minimum 8 GB 

onwards. Operating system: 

Windows 10 onwards 

01 System 

for each 

Student 

 

2 
Software 

Microsoft Office, Office 

365- Excel 

VIII. Conclusion 

…………………………………………………………………………………………………….. 

…………………………………………………………………………………………………….. 

…………………………………………………………………………………………………….. 
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IX. Practical Related Questions 

Note: Below given are few sample questions for reference. Teachers must design more such 

questions to ensure the achievement of identified CO. 

1. Create a basic bar chart using data of your department students and change its 

type to a different chart. 

2. How to move all data labels at the same time? 

3. Create a dataset using your college/department staff and perform the activities 

such as adding data labels, changing the axis format, and adjusting the gridlines. 

4. How can you ensure that the legend doesn't overlap or obstruct other elements of 

the plot? 

5. What are the best practices for choosing the location and style of a legend in 

different types of visualizations (e.g., line charts, bar charts, scatter plots)? 

6. If you need to display two or more legends on the same plot, how can you do so in 

a way that doesn't interfere with the overall presentation? 

7. Create a chart using sales data of a company and change the data labels to include 

the category as well as the percentage and position the labels in the outside end 

location? 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 
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…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

X. References: 

1. https://support.microsoft.com/en-us/office/create-a-bar-chart-14832c6e-0a66-458d-

82e2-7fd3bce4d05a 

2.  https://www.ablebits.com/office-addins-blog/make-bar-graph-excel/ 

3.  https://books.libreoffice.org/en/CG71/CG7103-ChartsAndGraphs.html 

XI. Assessment Scheme (25 Marks) 

S. No. Weightage- Process related: 60% Marks-15 

1. Logic formation:30%  

2. Debugging ability:20% 

3. Follow ethical practices:10% 

 Weightage- Product related: 40% Marks-10 

4. Expected output:15%  

5. Timely Submission:15% 

6. Answer to sample questions:10% 

 
Total 25 

 

  

Dated Signature of Course Teacher 

 

 

 

https://support.microsoft.com/en-us/office/create-a-bar-chart-14832c6e-0a66-458d-82e2-7fd3bce4d05a
https://support.microsoft.com/en-us/office/create-a-bar-chart-14832c6e-0a66-458d-82e2-7fd3bce4d05a
https://www.ablebits.com/office-addins-blog/make-bar-graph-excel/
https://books.libreoffice.org/en/CG71/CG7103-ChartsAndGraphs.html
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Practical No. 8 

a. Create a Pie Chart from a dataset 

b. Move the pie chart to a new worksheet for better visibility 

c. Emphasize a specific category by exploding a slice of the pie chart 

d. Customize the appearance of the pie chart for better presentation 

I. Practical Significance 

Creating a pie chart from a dataset allows for a visual representation of proportional 

data, where each slice represents a different category and its size relative to the whole. Moving 

the pie chart to a new worksheet improves readability by isolating it from other elements on the 

original sheet. Emphasizing a specific category by exploding a slice visually highlights its 

importance. Customizing the appearance of the pie chart with colours, labels, and formatting 

enhances its visual appeal and understanding.  

II. Industry / Employer Expected Outcome(s) 

Perform Data Analytics in various business domains for improved decision making 

III. Course Level Learning Outcomes(s) 

CO4 - Represent data in terms of various types of charts. 

IV. Laboratory Learning Outcome(s) 

LLO 8.1 Design a Pie Chart. 

V.  Relevant Affective Domain related Outcomes 

a. Follow precautionary measures. 

b. Follow naming conventions. 

c. Follow ethical practices 

VI. Relevant Theoretical Background 

To create a pie chart, move it to a new sheet, emphasize a slice, and customize its appearance in 

Excel: 

1. Create a pie chart: 

Highlight the data you want to chart in your spreadsheet.  Go to the Insert tab.  Select 

Pie Chart and choose the desired style (e.g., 2D, 3D, and doughnut).  
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Fig: Create a Pie Chart 

2. Move the pie chart to a new sheet: 

Click on the pie chart. Right-click and select Cut. Navigate to the new worksheet where 

you want to place the chart. Right-click and select Paste. 

3. Emphasize a slice by exploding it:  

To emphasize a slice in a pie chart by exploding it in Microsoft Office 365, you can use 

the "Pie Explosion" feature in Excel.  

 Click on the pie chart to select it. 

 Click again on the slice you want to emphasize (only that slice should be 

selected). 

 Drag the selected slice slightly away from the centre. This will "explode" it. 

Alternatively, right-click the slice, choose Format Data Point (or Format Data 

Series) and increase the Point Explosion or Pie Explosion. (In short Right-click 

the pie chart, then click Format Data Series. Drag the Pie Explosion slider to 

increase the separation or enter a number in the percentage box.) 

  
Fig: Emphasize a slice by exploding 
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4. Customize the pie chart's appearance: 

 Change colours: Click the pie chart, then go to the Chart Design tab.  Select "Color" to 

choose a new colour scheme or customize individual slices.  

 Add labels: Click the chart, then go to the Chart Elements section. Select "Data Labels" 

to add labels with percentages or values directly onto the slices. 

 Add a title: Click the chart, then add a title in the Chart Title section.  

 Adjust chart style: Use the Chart Styles options to modify the overall look and feel of 

the pie chart (e.g., gridlines, legend, etc.). 

VII. Resources Required  

Sr. 

No. 

Name of 

Resource 

Broad Specification Quantity Remark (if any) 

1 
Computer 

System 

Computer (i5 preferable), RAM 

minimum 8 GB onwards. Operating 

system: Windows 10 onwards 01 System for 

each Student 

 

2 
Software 

Microsoft Office, Office 365- Excel 

VIII. Conclusion 

…………………………………………………………………………………………………….. 

…………………………………………………………………………………………………….. 

…………………………………………………………………………………………………….. 

IX. Practical Related Questions 

Note: Below given are few sample questions for reference. Teachers must design more such 

questions to ensure the achievement of identified CO. 

1. Create a pie chart for using data of your department students to show the 

attendance of a month. 

2. What is the explosion effect on a pie chart? 

3. Create a pie chart for sale of different fruits in a day for a shop and move the pie 

chart to a new worksheet for better visibility. 

4. Create a pie chart of unit test result of your class and emphasize a specific 

category by exploding a slice of the pie chart.  

5. You have a dataset containing sales figures for four products: Product A (40), 

Product B (30), Product C (20), and Product D (10). Create a pie chart that shows 

the sales distribution among these products in Excel and apply a more 

professional-looking style. Also explain how can you apply a pre-defined style to 

your pie chart to make it look more polished? 
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6. You have multiple charts in your Excel file and want to organize them better. 

After creating a pie chart for your sales data, move it to its own worksheet without 

affecting the rest of the data? 

7. Create a pie chart showing the distribution of market share among different 

products, also explode the slice representing the product with the highest market 

share to make it stand out? 

8. Create a pie chart for your company's quarterly sales, as well as emphasize the 

quarter with the highest sales and highlight this quarter in your pie chart? 

9. The following data distribution depicts the marks of 35 students of a particular 

standard. Draw a pie chart for the given. 

Marks (in %) 40-50 50-60 60-70 70-80 80-90 90-100 

Number of students 5 4 6 8 6 5 

 

…………………………………………………………………………………………………………….. 
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…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

X. References: 

1.  https://www.ablebits.com/office-addins-blog/make-pie-chart-excel/ 

2. https://www.geeksforgeeks.org/how-to-create-pie-of-pie-chart-in-excel/ 

3. https://www.datacamp.com/tutorial/pie-chart-in-excel 

XI. Assessment Scheme (25 Marks) 

S. No. Weightage- Process related: 60% Marks-15 

1. Logic formation:30%  

2. Debugging ability:20% 

3. Follow ethical practices:10% 

 Weightage- Product related: 40% Marks-10 

4. Expected output:15%  

5. Timely Submission:15% 

6. Answer to sample questions:10% 

 
Total 25 

 

  

Dated Signature of Course Teacher 

 

 

https://www.ablebits.com/office-addins-blog/make-pie-chart-excel/
https://www.geeksforgeeks.org/how-to-create-pie-of-pie-chart-in-excel/
https://www.datacamp.com/tutorial/pie-chart-in-excel
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Practical No. 9  

* Create different types of plots. Write a Python script to save the plot in different formats: PNG, 

PDF, and SVG. 

I. Practical Significance 

In data analysis and visualization, creating different types of plots can help 

communicate findings clearly and effectively. The practical significance of different types of 

plots lies in the ability to represent data visually, which aids in uncovering trends, patterns, 

relationships, and outliers in datasets. Depending on the context, the Line Plot, Bar Plot, 

Histogram, Scatter Plot, Pie Chart, Box Plot are commonly used.  

II. Industry / Employer Expected Outcome(s) 

Perform Data Analytics in various business domains for improved decision making 

III. Course Level Learning Outcomes(s) 

CO5 - Visualize the data using a Python library. 

IV. Laboratory Learning Outcome(s) 

LLO 9.1 Generate and Save the plot in various formats. 

V.  Relevant Affective Domain related Outcomes 

a. Follow precautionary measures. 

b. Follow naming conventions. 

c. Follow ethical practices 

VI. Relevant Theoretical Background 

Steps to Create and Save Different Types of Plots in Python: 

Step 1: Install Required Libraries 

You need two libraries for this task: 

1) matplotlib for creating the plots. 

2) numpy for generating data (such as the sine wave or random values). 

To install them, open your terminal or command prompt and run the following code- 

pip install matplotlib numpy 

Step 2: Import the Necessary Libraries 

Start by importing the required libraries for plotting and handling data write following 

code in Python Editor  
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import matplotlib.pyplot as plt 

import numpy as np 

matplotlib.pyplot provides a MATLAB-like interface for making plots. 

numpy helps in creating arrays and mathematical operations, such as generating the sine 

wave and random data. 

Step 3: Prepare the Data for Plotting 

Now, prepare the data that you will plot. For this example, we'll create a sine wave for 

the line plot, random values for the bar plot, and a scatter plot with random points. 

Write following code in Python Editor- 

# Data for the plots 

x = np.linspace(0, 10, 100)       # Line plot data (X-axis) 

y = np.sin(x)                      # Line plot data (Y-axis, sine function) 

y_bar = np.random.rand(5)          # Bar plot data (random values) 

x_bar = ['A', 'B', 'C', 'D', 'E']  # Bar plot categories 

x_scatter = np.random.rand(50)     # Scatter plot data (X values) 

y_scatter = np.random.rand(50)     # Scatter plot data (Y values) 

Explanation: 

Line Plot: x is created using np.linspace(), and y is the sine of x. 

Bar Plot: y_bar contains random values, and x_bar defines the categories (labels). 

Scatter Plot: x_scatter and y_scatter are arrays of random values. 

Step 4: Create the Plot with Multiple Subplots 

We will use the plt.subplots() function to create a figure with three subplots stacked 

vertically. 

# Create a figure to hold the plots by witing following code 

fig, axs = plt.subplots(3, 1, figsize=(6, 12))  # 3 rows, 1 column 

Here 3, 1: Specifies the number of rows and columns (3 rows, 1 column). 

figsize: Sets the size of the entire figure. 
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Step 5: Create the Line Plot 

Next, we create a line plot on the first subplot (axs[0]) by writing following code- 

# Line Plot 

axs[0].plot(x, y, label="Sine Wave", color='b')  # 'b' stands for blue 

axs[0].set_title("Line Plot")                    # Set title 

axs[0].set_xlabel("X-axis")                      # X-axis label 

axs[0].set_ylabel("Y-axis")                      # Y-axis label 

axs[0].legend()                                  # Show legend 

Step 6: Create the Bar Plot 

For the bar plot, use the second subplot (axs[1]) and write as follows:- 

# Bar Plot 

axs[1].bar(x_bar, y_bar, color='g')  # 'g' stands for green 

axs[1].set_title("Bar Plot")          # Set title 

axs[1].set_xlabel("Categories")      # X-axis label 

axs[1].set_ylabel("Values")          # Y-axis label 

Step 7: Create the Scatter Plot 

For the scatter plot, use the third subplot (axs[2]) and write as follows:- 

# Scatter Plot 

axs[2].scatter(x_scatter, y_scatter, color='r')  # 'r' stands for red 

axs[2].set_title("Scatter Plot")                  # Set title 

axs[2].set_xlabel("X-axis")                       # X-axis label 

axs[2].set_ylabel("Y-axis")                       # Y-axis label 

Step 8: Adjust Layout and Display the Plots 

We use plt.tight_layout() to automatically adjust subplot spacing, ensuring that titles 

and labels do not overlap. 

# Adjust layout 
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plt.tight_layout() 

Finally, use plt.show() to display the plots in a window. 

# Show the plot 

plt.show() 

Step 9: Save the Plots in Different Formats 

Now, use plt.savefig() to save the plot in multiple formats: PNG, PDF, and SVG. 

# Save the plot in different formats 

plt.savefig('plot.png')   # Save as PNG 

plt.savefig('plot.pdf')   # Save as PDF 

plt.savefig('plot.svg')   # Save as SVG 

Step 10: Run the Script 

After setting up the code as shown above, simply run the script in your Python 

environment or IDE. You should see the plots displayed, and the plot.png, plot.pdf, and 

plot.svg files will be saved in the same directory where you run the script. 

VII. Resources Required  

Sr. 

No. 

Name of 

Resource 

Broad Specification Quantity Remark (if any) 

1 

Computer 

System 

Computer (i5 preferable), RAM 

minimum 8 GB onwards. 

Operating system: Windows 10 

onwards 
01 System for 

each Student 

 

2 Software Editor: Python setup 

VIII. Conclusion 

…………………………………………………………………………………………………….. 

…………………………………………………………………………………………………….. 

…………………………………………………………………………………………………….. 
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IX. Practical Related Questions 

Note: Below given are few sample questions for reference. Teachers must design more such 

questions to ensure the achievement of identified CO. 

1. Write a Python script to create a simple line plot of the function y=x
2
 and save it in 

PNG, PDF, and SVG formats. What is the explosion effect on a pie chart? 

2. Write a Python script to create a bar chart displaying the sales of a product over 6 

months and save the plot in PNG, PDF, and SVG formats. 

3. Write a Python script to create a scatter plot for two variables, x and y, and save it 

as a PNG, PDF, and SVG file. 

4. Write a Python script to create a histogram from a random dataset and save it in 

PNG, PDF, and SVG formats. 

5. Write a Python script to create a pie chart that shows the distribution of market 

share among 5 companies, and save it as PNG, PDF, and SVG files. 

6. Write a Python script to create a heatmap of a 10x10 matrix and save it as PNG, 

PDF, and SVG files. 

7. Write a Python script to create a box plot showing the distribution of 5 different 

datasets, and save it as PNG, PDF, and SVG files. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 
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…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

X. References: 

1.  https://www.geeksforgeeks.org/how-to-save-a-plot-to-a-file-using-matplotlib/ 

2. https://mljar.com/blog/matplotlib-save-plot/ 

3. https://swcarpentry.github.io/python-novice-gapminder/09-plotting.html 

XI. Assessment Scheme (25 Marks) 

S. No. Weightage- Process related: 60% Marks-15 

1. Logic formation:30%  

2. Debugging ability:20% 

3. Follow ethical practices:10% 

 Weightage- Product related: 40% Marks-10 

4. Expected output:15%  

5. Timely Submission:15% 

6. Answer to sample questions:10% 

 
Total 25 

 

  

Dated Signature of Course Teacher 

 

 

https://www.geeksforgeeks.org/how-to-save-a-plot-to-a-file-using-matplotlib/
https://mljar.com/blog/matplotlib-save-plot/
https://swcarpentry.github.io/python-novice-gapminder/09-plotting.html
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Practical No. 10 

Application of data analytics across various industries through case study 

I. Practical Significance 

The practical significance of analysing data analytics applications across various 

business domains lies in the ability to make informed, data-driven decisions that enhance 

efficiency, reduce costs, improve customer experiences, and ultimately drive growth and 

profitability. Here‘s a closer look at the real-world impact of applying data analytics in key 

business sectors like Retail and E-Commerce, Finance and Banking, Healthcare etc.  

II. Industry / Employer Expected Outcome(s) 

Perform Data Analytics in various business domains for improved decision making 

III. Course Level Learning Outcomes(s) 

CO5 - Visualize the data using a Python library. 

IV. Laboratory Learning Outcome(s) 

LLO 10.1 Analyse data analytics applications across various business domains. 

V.  Relevant Affective Domain related Outcomes 

a. Follow precautionary measures. 

b. Follow naming conventions. 

c. Follow ethical practices 

VI. Relevant Theoretical Background 

Data analytics has a wide range of applications across various industries, from 

fraud detection in banking to personalized customer experiences in retail. Here's a look at 

some key areas: 

1. Finance: 

 Fraud Detection: Banks use machine learning algorithms to identify anomalous 

transaction patterns, flagging potential fraudulent activities.  

 Risk Management: Data analytics helps insurance companies assess and manage risks, 

while financial institutions use it to analyse market trends and predict investment 

performance.  

2. Retail: 

 Customer Segmentation: Data analytics helps retailers understand customer behavior, 

personalize shopping experiences, and optimize marketing campaigns.  
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 Supply Chain Optimization: Data analytics helps retailers optimize supply chains, 

reducing costs and improving efficiency.  

3. Manufacturing: 

 Predictive Maintenance: Data analytics helps manufacturers predict equipment 

failures, allowing for proactive maintenance and reducing downtime.  

 Production Efficiency: Companies like Siemens have used data analytics to increase 

production efficiency and reduce production time.  

4. Healthcare:  

 Disease Prediction: Data analytics helps predict the spread of diseases and personalize 

patient care, leading to better treatment outcomes. 

 Drug Discovery: Data analytics accelerates drug discovery and development, helping 

researchers identify new drug candidates and optimize clinical trials. 

5. Government:  

 Crime Prevention: Data analytics helps security agencies track criminal activities, 

enhance surveillance, and predict security threats in real time. 

 Program Evaluation: Governments use data analytics to monitor the performance of 

welfare schemes and programs, ensuring effectiveness and accountability. 

6. Other Industries: 

 Marketing: Data analytics helps companies understand customer behavior, optimize 

marketing campaigns, and improve targeting strategies.  

 Telecommunications: Data analytics helps telecommunications companies optimize 

networks, improve customer service, and personalize offerings.  

 Transportation:  Data analytics helps transportation companies optimize routes, reduce 

congestion, and improve safety. 

Data Analytics helps to reduce delivery time and Improve Supply Chain 

Case Study: - Amazon: Optimizing Supply Chain and Inventory Management 

Company: Amazon 

Industry: E-Commerce 

Challenge: Managing vast inventory and optimizing supply chain logistics. 

 Solution: Utilizing real-time analytics and machine learning for demand forecasting 

and inventory management. 

 Overview: Amazon, a global e-commerce giant, has transformed its supply chain and 

inventory management through data analytics. The company‘s ability to predict demand 

and manage inventory efficiently has been a critical factor in its success. 

 Strategy: 
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 Real-Time Analytics: Amazon uses real-time data from its sales, customer 

behaviour, and supply chain operations to forecast demand and optimize 

inventory levels. 

 Machine Learning: Advanced machine learning models predict future product 

demand based on historical data, seasonality, and market trends. 

 Dynamic Pricing: Amazon implements dynamic pricing strategies, adjusting 

prices based on demand, competition, and other factors. 

 Results: 

 Improved Efficiency: Amazon‘s data-driven approach has streamlined its 

supply chain, reduced stock outs, and minimized excess inventory. 

 Enhanced Customer Experience: By ensuring that popular products are 

readily available and optimizing delivery times, Amazon has enhanced customer 

satisfaction and loyalty. 

VII. Resources Required  

Sr. 

No. 

Name of 

Resource 

Specification Quantity Remark (if 

any) 

1 

Computer 

System 

Computer (i5 preferable), 

RAM minimum 8 GB 

onwards. Operating system: 

Windows 10 onwards 
01 System for each 

Student 

 

2 
Software 

Excel 365 ,Editor: Python 

setup 

VIII. Conclusion 

…………………………………………………………………………………………………….. 

…………………………………………………………………………………………………….. 

…………………………………………………………………………………………………….. 

IX. Practical Related Questions 

Note: Below given are few sample questions for reference. Teachers must design more such 

questions to ensure the achievement of identified CO. 

1. Write a case study of how Data Analytics is revolutionizing the Manufacturing 

Industry? 

2. Write a case study of how Retailers using data analytics to Personalize the 

Shopping Experience? 

3. How Data Analytics is helping Financial Institutions to Combat Fraud? Explain. 

4. How Data Analytics help to reduce delivery time and Improve Supply Chain? 

Explain.  

5. How Telecom Companies are leveraging data analytics to improve various KPI? 

Explain. 
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6. How Insurance companies are using Data Analytics to improve various processes? 

Explain. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 
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…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 
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…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………….. 

…………………………………………………………………………………………………………...... 

X. References: 

1.  https://www.geekster.in/articles/case-studies-in-data-analytics-success-stories/ 

2.  https://www.sigmacomputing.com/blog/data-analytics-applications 

XI. Assessment Scheme (25 Marks) 

S. No. Weightage- Process related: 60% Marks-15 

1. Logic formation:30%  

2. Debugging ability:20% 

3. Follow ethical practices:10% 

 Weightage- Product related: 40% Marks-10 

4. Expected output:15%  

5. Timely Submission:15% 

6. Answer to sample questions:10% 

 
Total 25 

 

  

Dated Signature of Course Teacher 
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